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Part 4: MS Excel Spreadsheets
1. Introduction
Spreadsheet programs are used in the workplace to arrange data, make calculations, create graphs and charts and more. The following table gives a few examples of who and why people use spreadsheets:

	Accountants 
	to keep track of the money coming into and out of the business.

	Sports Broadcaster 
	to note, comment and present important sports statistics to their audience in a match

	Civil Engineers 
	to assist with the calculations required to construct roads, bridges and buildings

	Advertising executives
	to collect, compile and analyse answers to market research questions

	Teachers
	to record and calculate students attendance and results over a semester or a year

	Sales People
	to determine the volume and profit of items sold



According to Microsoft, more than 40 million people worldwide now use Excel.
This makes it the most popular spreadsheet of all time.

You can use Excel for the following (just to mention a few):
· To keep to a budget
· To process and manipulate data for your studies
· To provide sorted lists of results for your sports committee
· If you want to keep track of your marks

Learning outcomes
After completing this Part, learners will be able to demonstrate their understanding of Excel in terms of:
· Renaming, inserting and deleting a worksheet
· Inserting, deleting columns and rows and navigating cells
· Using Fill Handles, AutoFill, AutoComplete and inserting formulas
· Formatting Cells
· Saving Excel workbooks
· Create graphs and charts in MS Excel
· Format and label charts and graphs



2. Terminology
In order to learn to operate Excel, you should familiarise yourself with the following terminology.

	Spreadsheets
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	A spreadsheet is a large grid of cells arranged in rows and columns. Data (text, numbers and formula) are then entered into the cells and restructured for a person to examine.

Excel is the digital version of an accountant's worksheet. This application does much more than offering accountants neat rows and columns. It helps makes the repetitive tasks quicker and easier.
It can automatically do most of the calculating (and recalculating) for you. And it can allow you create a variety of charts and graphs to visually represent your data.

	Workbook
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	A complete Excel file is referred to as a Workbook.

	Work sheets
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	A Worksheet is a separate page within a Workbook. A Workbook could contain a number of separate Worksheets. To view a worksheet, take a look at the sheet tab at the bottom left of the workbook window. When you click each sheet, you’ll be able to view another worksheet. You can rename these sheets and create additional sheets

	The Ribbon

[image: ]

	At the top of the page is a feature called the Ribbon. The Ribbon consists of a number of tabs. Each tab contains specific commands.

The Ribbon is a new feature in Excel 2007. It replaces the toolbar.

	Columns
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	Much like pillars or posts, columns are the vertical cells. Letters, called Column Headers, identify these cells.

	Rows
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	Rows are the cells that go from left to right horizontally on the worksheet. Numbers, called Rows Headers, identify these cells.

	Cells
[image: ]
	Each small box within the grid on your page is known as a cell. Cells are identified by their column and row. E.g. cell C2 is in Column C and Row 2

	Active cells
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	The cell that has a heavy outline is known as the active cell. It is highlighted in black, to indicate that any data you enter will go in that cell. You can make a cell active by clicking on it, pressing tab, enter or the arrow keys. You will notice that the Columns and Rows of the active cell are highlighted.

	Fill Handles
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	The small squares that appear at the corners of the active cell are known as the fill handles

	Name box
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	Just below the ribbon, on the left of the page is the Name Box. The Name Box is used to show the cell reference of the active cell.

In this example, the cell is in Column H and Row 10.

	Formula bar
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	The formula bar is above the grid and to the right of the Name box.
The formula bar displays the data or formula stored in the active cell.





3. Working with Excel
In this section you will see how to use Excel. Read through the table below to familiarise yourself with the various things can do using Excel. You will return to these steps as you work through activities 3.1 and 3.2. If you are working at a computer, it would be a good idea to try out some of these processes while you read them.

	Creating a new workbook 
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	To create a new workbook:

1 click on the Office button on the top left
2 select New
3 click on Blank Workbook
4 a new workbook (with a different name) will open

	Inserting a worksheet into a workbook
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	To insert a new worksheet:

1. click the worksheet button on the right hand side of the sheet tabs

	Renaming a worksheet
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	To rename a worksheet:

1 Right-click the sheet tab of the sheet you want to rename
2 select rename
3 type in the name you want to give the worksheet

	Deleting a worksheet
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	To delete a worksheet:
1 Look at the Ribbon
2 Click the Home tab
3 in the Cells group, click the arrow on Delete
4 Delete Sheet

	Inserting and deleting columns
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	To insert a column:
1 click a cell immediately to the right of where you want to insert a new column.
2 click on the Home tab on the
3 Ribbon
4 click on the Cells group; click the arrow on Insert
5 click Insert Sheet Columns

To delete a column:
1 click a cell in the column
2 click on the Home tab
3 in the Cells group, click the arrow on Delete
4 Click Delete Sheet Columns

	Inserting and deleting rows
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	To insert a row:
1 click a cell in the row immediately below where you want the new row
2 click on the Home tab; in the Cells group, click the arrow on Insert
3 click Insert Sheet Rows

To delete a row:
1 click a cell in the row
2 click on the Home tab; in the Cells group, click the arrow on Delete.
3 click Delete Sheet Rows

Alternately you could use the right click function with your mouse.

1 select the row immediately below where you want to insert a new row Right-click your mouse and select insert
2 tick the box for the function you wish to perform

	Formatting a cell
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	There are a wide variety of formatting options:

1 Right click a cell and select
Format to see number, alignment, font, border fill and protection options.
2 To format a cell for currency, select the cell and right click. Click on the number tab, choose 2 decimals and select a country symbol. If you selected South Africa, your cell will then have an R symbol before it. If you selected USA, your cell will have a $ before it.

	Saving your work
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	It is important to remember to save your work often.

To save:
1 click the Save icon (next to the office button) on the top left hand side of the screen
2 the first time you save a workbook, you will need to give it a name
3 if you want to change the name later, or if you want to keep the old version in the old name and create a new version with a new name, click the office button and use the Save As option
4 this will create a duplicate file and save it under a new name
5 5. your old file with the old name will still be there, and you will now be working in the new file with the new name

	Using AutoFill

[image: ]
	You can use the AutoFill feature to enter the months of the year, days of the week, consecutive dates, or a series of numbers.

1 type one or more of the above entries
2 2. click on the small square (bottom right of the active cell); left-click your mouse and drag it across as many cells as you want “Autofilled”

	Using AutoComplete
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	You can use the AutoComplete feature to fill in the remaining characters for you. If the first few characters you type in a cell match an entry you've already made in the same column, Excel will complete the word automatically. Just press ENTER.

	Navigating cells
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	How to select cells:
A single cell:
click on the cell


A range of cells next to each other:
drag from the first cell you want to select to the last


Non adjacent cells or ranges:
hold CTRL (Windows) and click or drag an entire row or column OR click on the row or column heading


All cells:
click on the upper left corner


The next cell to the right :
use the Tab key or the arrow keys


The next cell down the column:
use the Enter key

	Using Formulas
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Click on C8 and type the following in the formula bar: =(C7-B7), then press Enter

Click on D3 and type the following in the formula bar: =(C3*12), then press Enter

	Excel allows you to apply a variety of formulas to your data; worksheets are automatically recalculated based on the mathematical formulas and functions that connect your information.

How to:
To add up the entertainment expenses for February:
1 Click on cell C7
2 type “=SUM(C3:C5)” which will add up cells C3, C4 and C5
3 OR “=(C3+C4+C5)”
4 press Enter
5 you should get the answer 1280
6 Look at the table on the left for other Maths operators you can use to subtract, multiply and divide.
7 You can add, subtract, multiply or divide cells however you like by applying formulas.

Examples:
Subtract the total January expenses from the total February expenses Multiply the DSTV expense of 500 by 12 to determine the annual expense:

	Working with Functions
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	Instead of entering lengthy formulas such as“=C2+C3+C4+C5+C6+C7+C8+C9+ C10” you could use the function SUM(C2:C10), which would save you a lot of time.
Have a look at the table on the left for time-saving functions you could use.

Useful shortcuts:

[image: ]

1. Highlight the values
You could highlight the values that you want to calculate the total of and click on the AutoSum icon. Excel will assume that you wish to calculate the total of the highlighted cells.

2. Enter Equals
When you type “=” and the first letter into the function bar, Excel assumes that you want to use a function and provides a list of common functions.

3. AutoAverage
Click a cell below the numbers for which you want to find the average and then click the arrow next to AutoSum, on Average, and press ENTER.
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	Practical Learning Activity 3.1



Now you need to apply what you have learned so far. Follow the instructions below and make a note in the space provided of the steps taken to complete the activity. The image below is what your spreadsheet should look like at THE END; follow the instructions carefully.
[image: ]
Instructions:
1 Create a new workbook and name it:
NameSurname_Part4_Section1_Activity_3.1
2 Delete worksheet 3 so that you only have 2 worksheets
3 Rename your worksheets Grocery List and Monthly Expenses
4 Type the heading Product Name in column A; January in column B and Projected annual expense in column C
5 Directly under Product Name, type in Cheese, Chicken, Fruit, Vegetables, Handy Andy, Bread, Cold meats, Toilet paper and Total
6 Format column C (January) as follows: Currency, Symbol R, 2 decimal places
7 Directly under January, type in 25; 45; 20; 20; 16.5; 9.5; 24; and 36 
8 Insert a row between Product Name and Cheese and another row between Toilet paper and Total
9 Bold Row 12
10 Calculate the total expenses for January using a formula
11 Insert a column to the left of Product Name and type in corresponding numbers for the grocery products from 1 to 8; double-click on the column heading to auto-size it.
12 Select ALL cells and Left-align them
13 Insert a column to the right of January
14 Use the AutoFill function to give the new column a heading
15 Select Cells D3 through to D10 and use the AutoFill function to allocate the same expenses for this new column
16 Use the AutoFill function to determine the total expenses for the new column
17 Select Cell E12 and calculate the projected annual expense for groceries using a formula
18 Save your document
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	Group Learning Activity 3.2



Work together with a partner to complete the following quiz to see how much you understand about Formula and functions with this ten question multiple choice quiz.

[image: ]

	1 If you enter the formula = 5*3+4*5 into a cell and press enter, the cell will display the following value:
	a 17
b 35
c 1
d The formula will not work

	2 Which formula would you enter into F2 to find Bhengu’s average:
	a 58+55+56/3=
b =(B2:D2)/3
c =(58+55+56)3
d =AVERAGE(B2:D2)

	3 If you have the formula =B2+C2+D2 in cell F2 and you copy that formula to cell F3 what will the result be:
	a 169
b 182
c 204
d None of the above

	4 A quickest way to add up Bhengu’s total is to click on E2 and:
	a Click the data tab on the ribbon menu and click the subtotal button
b Enter = and the answer will appear in the formula bar
c Click the AutoSum button on the home menu
d Highlight the cell and click F11

	5 Chetty’s total results were 182. If you looked in the formula bar, what would the formula that added up the three assignments look like?
	a =SUM(B3:D3)
b =ADD(B3:D3)
c B2+C2+D2 =
d =AUTOSUM(B3:D3)

	6 If you wanted to quickly apply the formula used in E2 to E3 and E4, you would…
	a Copy the cell with the formula, and then place the insertion point in the cell you want to copy it to and press enter and then repeat until all the cells had the formula
b Click the data tab on the ribbon menu and click the Auto copy and paste formula button
c Click on the cell, click on the fill handle at the bottom left and drag it over the selected cells
d Drag the Paste button on the Standard Toolbar across the cells and then click in the formula bar.

	7 What function would be the best to use to calculate Bhengu, Chetty and Harvey’s average total:
	a RAND
b AVERAGE
c MAX
d COUNT

	8 Look at the marksheet above. What is the correct formula to automatically determine the average marks in cells E1 to E3? Please select an answer...
	a =AVERAGE(E2,E3,E4)
b =AVERAGE(E2:E4)
c =SUM(E2:E4)/COUNT(E2:E4)
d All are correct


Feedback [footnoteRef:0] [0:  1b, 2b, 3b, 4c, 5c, 6c, 7b, 8d] 












	Working with Graphs and Charts

Excel’s chart and graphing capacities are a good place to start when using graphs to explain complex information.

Graphs and charts allow us to visualise data and communicate information clearly and efficiently. Viewers of a chart or graph can quickly make comparisons, identify patterns and spot trends. 

Sometimes the complex combinations of text and numbers in spreadsheets can be confusing. Graphs and charts attempt to assist people to view, compare and analyse data. They display the relationship between numbers and amounts visually.

	Types of Graphs

Bar Graphs
[image: ]

Pie Charts
[image: ]
	If you need to compare values side by side, then bar graphs are most useful for showing the contrast in item numbers. A bar graph consists of a vertical and horizontal axis and bars can run horizontally or vertically. These bars are used to show different values.

The bar graph on the left shows the sale of items on a day-to-day basis, for one week. The blue bar (on the left) represents how much Coke was sold on each day; red (the middle bar) reflects the sale of chips and the green bar (on the right) shows how many Bar Ones were sold.

If you need to show the size of the parts that make up a whole, then pie charts are useful for showing the contrasting proportions. The larger the slice in the pie, the greater percentage of the information. They are useful when you want to emphasize a significant element.

The chart alongside represents the proportion of items sold as a slice of the pie. Almost half of items sold were Cokes and the least popular item was the Bar One.

	Line Graphs

[image: ]
	A line graph is useful for showing a pattern over time. Such a graph is usually used to display the relationships between two pieces of information and how they vary.

The line graph on the left shows which day was the post profitable day in the week. The net profit runs on the X axis (vertically), while the days of the week run along the Y axis (horizontally).

	Creating a graph
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	To create a chart in Excel, you enter the data for the chart on a worksheet. The data can be arranged in rows or columns, Excel automatically determines the best way to plot the data in the chart.

Steps:
1. Highlight the data you would like reflected in the chart
2. Click INSERT and SELECT your chart type
3. The chart will appear below the table in the Excel spreadsheet

Now you can modify the look of your chart as well as the data that is displayed in it.
Select your chart and you will see three new ribbons in the menu bar (Design, Layout and Format). These ribbons allow you to customize all aspects of your chart.

Follow the steps on the following page to see how to customise your graph.

	Design Ribbon
[image: ]

Layout Ribbon
[image: ]

Layout Ribbon
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	If you click on the Design tab, you’ll be able to make changes to the basic options regarding the chart (change the type of chart, change the data that you want displayed in the chart, change the layout of the chart, what kind of chart is it, etc.). 

If you click on the layout tab, then you will be able to add/edit/delete chart items like the title, legend, and so on. 

Format allows you to change the appearance of the chart.
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	Practical Learning Activity 3.3



1 Use the grocery list from activity 3.1 to generate 2 types of graph (e.g. a pie and bar chart).
2 You must also specify which type of graph you think works best to represent the information and why.
3 Furthermore, play around with the Design, Layout and Format ribbons to generate original, colourful graphs.


5. Tracking my progress
You have reached the end of this section. Check whether you have achieved the learning outcomes for this section. 

	LEARNING OUTCOMES
	 I FEEL CONFIDENT
	 I STILL NEED PRACTICE

	Renaming, inserting and deleting a worksheet
	
	

	Inserting, deleting columns and rows and navigating cells
	
	

	Using Fill Handles, AutoFill, AutoComplete and inserting formulas
	
	

	Formatting Cells
	
	

	Saving Excel workbooks
	
	

	Create graphs and charts in MS Excel
	
	

	Format and label charts and graphs
	
	




What did you like best about this section?
	

	

	

	




What did you find most difficult in this section?
	

	

	

	




What do you need to improve on? How will you do this?
	

	

	

	






How will you do this?
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